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Before You Begin

Who Should Use This Manual
This manual is for system administrators responsible for installing, configuring,
deploying, and maintaining Citrix ICA Client for Macintosh (also called the
Citrix ICA Macintosh Client). This manual assumes knowledge of:

� Citrix MetaFrame or Citrix WINFRAME

� The operating system on the client computer (MacOS)

� Installation, operation, and maintenance of network and asynchronous
communication hardware, including serial ports, modems, and device adapters

How to Use This Guide
To get the most out of the Citrix ICA Client Administrator’s Guide, review the
table of contents to familiarize yourself with the topics discussed.

This guide contains the following sections:

Chapter Contents

Chapter 1, “Introduction to the
Citrix ICA Macintosh Client”

Gives a detailed list of features.

Chapter 2, “Deploying the ICA
Macintosh Client”

Describes how to install and deploy the Citrix ICA
Macintosh Client.

Chapter 3, “Configuring the
Citrix ICA Macintosh Client”

Describes how to configure connection properties
and device mappings for the Citrix ICA Macintosh
Client.
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Document Conventions
The following conventional terms, text formats, and symbols are used throughout
the printed documentation:

The Citrix ICA Client for Macintosh allows users to connect to MetaFrame and
WINFRAME servers. When describing a feature or procedure common to all types
of MetaFrame and WINFRAME servers, this manual uses the term Citrix server.
When describing a feature unique to a particular MetaFrame or WINFRAME server,
this manual specifies the appropriate server and version number.

Convention Meaning

Bold Indicates column headings, command-line
commands and options, dialog box titles, lists, menu
names, tab names, menu commands, and actual
parameter names.

Italic Indicates a placeholder for information or
parameters that you must provide. For example, if
the procedure asks you to type filename, you must
type the actual name of a file. Italic also indicates
new terms and the titles of other books.

ALL UPPERCASE Represents keyboard keys (for example, CTRL,
ENTER, F2).

[brackets] Encloses optional items in syntax statements. For
example, [password] indicates that you can choose
to type a password with the command. Type only the
information within the brackets, not the brackets
themselves.

Monospace Represents examples of text files.

WTSRV or %SystemRoot% Refers to the system tree. This can be \WTSRV,
\WINNT, \WINDOWS, or whatever other directory
name you specify when you install your software.

...(ellipsis) Indicates that you can repeat the previous item(s) in
syntax statements. For example,

/route:devicename[,...] indicates that you can
specify more than one device, putting commas
between the device names.
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Finding More Information
This manual contains conceptual information and installation and configuration
steps for the Citrix ICA Macintosh Client. For additional information, consult the
following:

� AppleGuide Help for the Client and the ICA Client Editor: this is shipped with
the client software.

� The Citrix ICA Client Administrator’s Guides for the other ICA Clients you
deploy.

� For instructions on installing, configuring, and maintaining your Citrix
servers, see the documentation in your MetaFrame or WINFRAME package.

Other Citrix ICA Client documentation may be available in Adobe PDF format in
the documentation folders of each Citrix CD-ROM, and on the Citrix Technical
Support Services site at http://www.citrix.com. Using the Adobe Acrobat Reader,
you can view and search the documentation electronically or print it for easy
reference. To download the Adobe Acrobat Reader for free, please go to Adobe’s
Web site at http://www.adobe.com.

Important Always consult the Readme files for MetaFrame, WINFRAME, and the
Citrix ICA Clients for any last-minute updates, known issues, and corrections to
the documentation.

Citrix on the World Wide Web
Citrix offers online Technical Support Services at http://www.citrix.com that
include the following:

� Adobe PDF versions of all current Citrix technical publications

� Downloadable Citrix ICA Clients, available at http://download.citrix.com

� A Frequently Asked Questions page with answers to the most common
technical issues

� An FTP server containing the latest service packs and hotfixes for download

� An Online Knowledge Base containing an extensive collection of technical
articles, troubleshooting tips, and white papers

� Interactive online support forums

� The Citrix Developer Network (CDN) available at http://www.citrix.com/cdn

This new, open enrollment membership program provides access to developer
tool kits, technical information, and test programs for software and hardware
vendors, system integrators, ICA licensees, and corporate IT developers who
incorporate Citrix server-based computing solutions into their products.
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Reader Comments
It is our goal to provide well-written, accurate, clear, complete, and usable
documentation for Citrix products. If you have any comments, corrections, or
suggestions for improving our documentation, we would be happy to hear from
you. You can email the authors at:

documentation@citrix.com

Please include the name and version number of the product and the title of the
document in your email.
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1
C H A P T E R 1

Introduction to the Citrix ICA
Macintosh Client

Overview
When connected to a Citrix server, the Citrix ICA Macintosh Client provides
additional features that make remote computing just like running applications on
a local desktop. The Citrix ICA Macintosh Client has the following features:

� Client device mapping

� Client drive mapping

� Client COM port mapping

� Client audio mapping

� Client printing

� Encryption

� Client Auto Update

� Local clipboard integration

� Low bandwidth requirements

� Disk caching and data compression

� SpeedScreen Latency Reduction

� Application publishing support

� Business recovery support

� PC key mapping

� Multiple session support

Some client features are available only when connecting to MetaFrame for
Windows NT and MetaFrame for Windows 2000 servers.



6 Citrix ICA Macintosh Client Administrator’s Guide

Client Device Mapping
The ICA Client supports client device mapping. Client device mapping allows a
remote application running on the Citrix server to access devices attached to the
local client computer. Users can access the client computer’s local disk drives,
devices attached to the local COM ports, and audio devices. Note that client
device mapping is not supported when connecting to MetaFrame for UNIX 1.0
and 1.1 servers.

Client Drive Mapping
Client drive mapping allows you to access the local disk drives of the client
computer from ICA sessions. When both the Citrix server and ICA Client are
configured to allow client drive mapping, you can access your locally stored files,
work with them from ICA sessions, and then save them either on a local drive or
on a drive on the Citrix server.

Client COM Port Mapping
Client COM port mapping allows devices attached to the client computer’s COM
ports to be used from ICA sessions on a Citrix server. This allows local devices
like modems and serial printers to be used by applications running on the Citrix
server.

Client Audio Mapping
Audio mapping allows your client computer to play sounds generated by
applications running on the Citrix server.

ICA Client audio support includes configurable sound quality levels that allow
you to customize sound quality based upon the amount of bandwidth available.

Client Printing
Users can access printers attached to their computers during ICA sessions. When
a Citrix server is configured to allow client printing, applications running
remotely on the server can print to local printers. You can print to a PostScript
printer, or to a PC printer connected to the Macintosh serial port. For more
information, see “Printing From the Macintosh Client.”
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Encryption
The ICA Client supports different levels of encryption, including advanced RSA
RC5 encryption.

Note To enable encryption levels higher than Basic, the Citrix server must
support RC5 encryption. This support is included with SecureICA Services and
Feature Release 1. SecureICA Services is not supported by all Citrix servers.

Client Auto Update
The Client Auto Update feature allows administrators to update ICA Client
installations from a central location instead of having to manually install new
versions of the ICA Client on each client computer. New versions of Citrix ICA
Clients are stored in a central Client Update Database on a WINFRAME or
MetaFrame for Windows server. The latest versions of the ICA Client are
downloaded to ICA Client devices when users connect to the server.

Local Clipboard Integration
You can use the client workstation’s clipboard to cut and paste objects between
applications running locally on the client computer and applications running
remotely in an ICA session.

Access to the local clipboard requires no special configuration or procedures;
using the familiar cut, copy, and paste commands, you can transfer text, pictures,
and other objects back and forth between local and remote applications. Note that
not all server platforms support all media types on the clipboard.

Low Bandwidth Requirements
The highly efficient Citrix ICA protocol typically uses 20K of bandwidth for each
session.

Disk Caching, Data Compression
These features can increase performance over low speed asynchronous and WAN
connections. Disk caching stores commonly used portions of your screen (such as
icons and bitmaps) locally, increasing performance by avoiding retransmission of
locally cached data. Data compression reduces the amount of data sent over the
communications link to the client.
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SpeedScreen Latency Reduction
SpeedScreen Latency Reduction enhances the user’s experience on slower
network connections. Note that SpeedScreen Latency Reduction is not available
when connecting to MetaFrame for UNIX 1.0 and 1.1 servers.

Application Publishing Support
You can create a remote application entry to connect to a Citrix server or to a
published application that contains all of the information necessary to launch a
user session or an application.

Business Recovery Support
The ICA Client includes the additional intelligence to support multiple server
sites (such as a primary and hot backup) with different addresses for the same
published application name.

This feature provides consistent connections to published applications in the
event of a primary server disruption.

PC Key Mapping
Your Macintosh mouse and keyboard can be used in an ICA session in the usual
way. You can use the following special key combinations to enter PC keys not
available on standard Macintosh keyboards:

Multiple Session Support
You can run multiple connections concurrently on the desktop. The sessions are
managed automatically, by the ICA Connection Center. When you have more
than one session in operation, each one appears as a separate entity in the
Macintosh Finder menu.

Note The ICA Connection Center allows up to 128 concurrent sessions, but the
amount of available memory also limits the number of connections.

PC Key ICA Macintosh Client Equivalent

ALT Command (also known as the Apple key)

Insert 0 (Zero on the numeric keypad; NUM LOCK must be off)

Del Dot on the numeric keypad; NUM LOCK must be off

Mouse right-click = key on numeric keypad, or Option and mouse click
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2
C H A P T E R 2

Deploying the ICA Macintosh Client

Overview
This chapter explains how to install the Citrix ICA Macintosh Client. Topics
covered in this chapter include:

� System requirements

� Installing the ICA Macintosh Client

� Preparing for Auto Client Update

� Using the Client Update Database

� Uninstalling the ICA Macintosh Client

About Installation
There are two ways to install the ICA Client:

� If your users are installing the client on machines that do not already have an
ICA Client installed on them, you must install the client manually. See
“Installing the ICA Macintosh Client.”

� If your users already have the ICA Client Version 4.1 or later, they can update
it automatically to this version if you add this client to the Client Update
Database. See “Using the Client Update Database.”
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System Requirements
Systems running the ICA Macintosh Client require the following:

� Macintosh processor: 68030/040 or PowerPC

� Operating system: System 7.1 or later

To run the ICA Macintosh Client on System 7.1, the Thread Manager system
extension must be installed. Thread Manager is available from Apple’s Web
site.

� 8MB of available memory

� 3MB of free disk space

� 16 or 256 color (or better) video display

� Open Transport TCP/IP Version 1.1.1 or later

� A network interface card (NIC) for network connections to Citrix servers

— or —

A modem and PPP networking software for serial connections to Citrix
servers

Installing the ICA Macintosh Client
� To install the ICA Macintosh Client

If you are installing the ICA Macintosh Client from a downloaded .hqx file, begin
with Step 4.

1. Insert the Citrix ICA Client CD-ROM in the client system’s CD-ROM drive.
Double-click the CD-ROM icon on your desktop.

2. Open ICAINST, open en and then double-click ICAMAC.

3. Copy the file Macica_sea.hqx to a temporary folder on the Macintosh hard
disk.

4. Decompress Macica_sea.hqx using an appropriate utility.

5. Open the Citrix ICA Client folder created by the decompression utility.

6. Double-click the Installer icon to run the installation program.

7. Follow the directions on your screen.
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Preparing for Client Auto Update
The ICA Macintosh Client can be set up so that you can automatically update it
from a WINFRAME or MetaFrame for Windows server when a newer version is
available. This means that you can “push” a new version of the client software
from a central database to the workstation instead of installing the client manually
at each workstation. You must be root to deploy the ICA Client.

Note ICA Client Auto Update is not supported by servers running WINFRAME 1.7
or earlier, or on MetaFrame for UNIX 1.0 or 1.1 servers.

� To enable the ICA Macintosh Client software for automatic update

1. Start the Citrix ICA Client Editor (see “Starting the ICA Client Editor” for
instructions).

2. From the Citrix ICA Client Editor Options menu, select Default Settings.
The Citrix ICA Client Editor Default Settings dialog box appears.

3. From the pop-up list at the top of the Default Settings dialog box, select the
Preferences page.

4. Select Allow Automatic Client Updates to allow the client to be
automatically updated with a newer version from the Citrix server.

Using the Client Update Database
If the version of the ICA Client currently installed supports client auto update,
future versions of the ICA Client can be automatically downloaded when a user
connects to a WINFRAME or MetaFrame for Windows server. The new versions of
the ICA Clients are downloaded from the Client Update Database.

Note ICA Client Auto Update is not supported by servers running WINFRAME 1.7
or earlier, or on MetaFrame for UNIX 1.0 or 1.1 servers.

ICA Client Auto Update for Macintosh works with TCP/IP and supports the
following features:

� Automatically detects older client files

� Provides full administrative control of client update options for each client

� Updates clients from a single database on a network share point

� Safely restores older client versions when needed

Note Client Auto Update is used to update client files to newer versions of the
same product and model.
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The Citrix ICA Client Update Process
Each ICA Client has a product number, model number, and version number. The
ICA Client product and model numbers uniquely identify the ICA Client.

The version number is the release number of the ICA Client.

The process of updating ICA Clients with new versions uses the standard ICA
protocol.

� The MetaFrame for Windows server queries the ICA Client when the user logs
on. If the server detects that the ICA Client is up-to-date, it continues the
logon transparently.

� If an update is needed, by default, the MetaFrame for Windows server informs
the user of the new client and asks to perform the update. You can specify that
the update occurs without informing the user and without allowing the user to
cancel the update.

� By default, the user can choose to wait for the client files to finish
downloading or to download the files in the background and continue
working. Users connecting to the MetaFrame for Windows server with a
modem get better performance waiting for the client update to complete. You
can force the client update to complete before allowing the user to continue.

� During the client update, new ICA Client files are copied to the ICA Client
device. The administrator can force the user to disconnect and complete the
update before continuing the session. The user must log on to the server again
to continue working.

� After disconnecting from the server, the ICA Client completes the update. All
client programs must be closed before the ICA Client can be updated.

� In case of a problem, the existing ICA Client files are saved to a folder called
Backup in the ICA Client directory.

Product/Model number Platform

1/1 ICA Client for DOS

14/1 ICA 32-bit Client for DOS

1/2 ICA Client for Win16

1/3 ICA Client for Win32

82/1 ICA Client for Macintosh
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Configuring the Client Update Database
During MetaFrame for Windows setup, a client update database is created that
contains the Citrix ICA Win32, Win16, Windows CE, Macintosh, UNIX, and
DOS Clients. By default, the update database is configured to update older client
versions.

You can configure a client update database on each MetaFrame for Windows
server in a server farm, or a single client update database on a central network
share. With a single database, you can configure updates once for all servers.

Use the ICA Client Update Configuration utility to:

� Create a new client update database

� Set a default client update database

� Configure database properties

� Add ICA Clients to the update database

� Remove ICA Clients from the update database

� Configure client update options

� To start the ICA Client Update Configuration utility

1. From a MetaFrame for Windows server: Click the Start button, point to
Programs, and then point to MetaFrame Tools. Click ICA Client Update
Configuration.

From a WINFRAME server: In the Administrative Tools folder, double-click
ICA Client Update Configuration.

2. The ICA Client Update Configuration dialog box appears.

The location of the current client update database is shown in the status bar.
This is the database the server uses to update ICA Clients. The main window
shows the ICA Clients currently configured in the database.
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Creating a New Client Update Database
The default location of the client update database on the server is %SystemRoot%
\Ica\Clientdb. A new database can be created on the local server hard drive or on
a shared network drive. Multiple servers can be configured to use one shared
client update database.

� To create a new client update database

1. From the Database menu, click New. The Path for the new Client Update
Database dialog box appears.

2. Enter a path for the new client update database and click OK.

A new client update database is created in the specified folder and the new
database is opened.

Setting a Default Database
An existing client update database can be used by multiple Citrix servers. If the
client update database is on a shared network drive, use the ICA Client Update
Configuration utility to configure all Citrix servers to use the shared database.

� To specify a new default database for one or more Citrix servers

1. From the Database menu, click Open. The Open Existing Database dialog
box appears.

2. Specify the path to the database that will be used as the default and click OK.

3. From the Database menu, click Set Default. The Set Default Database
dialog box appears.

4. Select the Set as Default Database on Local Machine check box to make the
currently opened database the default database.

Tip You can also set other Citrix servers to use the currently open database as
the default database. Double-click on a domain name to view the servers in
that domain. Click on a server to set its default database to the currently open
database. You can select multiple servers by holding down the CTRL key.

5. Click OK.
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Configuring the Properties of the Client Update Database
Use the Database Properties dialog box to configure the current client update
database.

� To configure the properties of the Client Update Database

On the Database menu, click Properties. The Database Properties dialog box
appears.

To disable this client update database, clear the Enabled check box. ICA Clients
are not updated if the database is not enabled.

The Default update properties for clients options specify the default behavior
for ICA Clients added to the update database. If you change the properties of an
individual client in the database, those properties will override the default
properties.

� In Client Download Mode, click Ask user to allow the user to choose to
accept or postpone the client update. Click Notify user to notify the user of
the client update and require the update. Click Transparent to update the
user’s ICA Client without notifying the user.

� In Version Checking, click Update older client versions only to update
client versions that are older than the new client. Click Update any client
version to update all client versions to this version of the client. Use this
option to force an older client to replace a newer client.

� In Update Mode, select the Force Disconnection check box to require users
to disconnect and complete the update. By default, users can choose whether
to disconnect and complete the client update after the new client files are
downloaded. Clear the Allow background download check box to force
users to wait for all client files to download before continuing. By default,
users can choose to download new client files in the background and continue
working.

� Select the Log Downloaded Clients check box to write an event in the event
log when an ICA Client is updated.

� By default, errors that occur during a client update are written to the event log.
Clear the Log Errors During Download check box to turn off error logging.

� Specify the maximum number of simultaneous updates per Citrix server.
When the specified number of client updates are occurring, new client
connections are not updated. When the number of client updates drops below
the specified maximum, new client connections are updated.
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Adding and Removing ICA Clients From the Database
Use the ICA Client Update Configuration utility to add ICA Clients to and
remove them from the database.

� To add a new ICA Client to the client update database

1. From the Client menu, click New. The Description dialog box appears.

Enter the path to the client installation file in Client Installation File or click
Browse.

The client installation file, Update.ini, is in a standard location for your
operating system: for example
%SystemRoot% \System32\Clients\ica\ica32\disks\disk1.

2. After you specify the client installation file, the Client Name, Product,
Model, Version, and icon of the selected client appear.

You can also modify the Comment used for this client. After making any
changes, click Next to continue.

3. The Update Options dialog box appears.

The Update Options dialog box controls how the client update occurs. These
options for each client override the settings specified for the database as a
whole in the Database Properties dialog box.

In Client Download Mode, click Ask user to give the user the option to
accept or postpone the client update. Click Notify user to notify the user of
the client update and require the update. Click Transparent to update the
user’s ICA Client without notifying the user.

In Version Checking, click Update older client versions only to update
client versions that are older than the new client. Click Update any client
version to update all client versions to this version of the client. Use this
option to force an older client to replace a newer client.

By default, users can choose to disconnect and complete the client update after
the new client files are downloaded. Select the Force Disconnection check
box to require users to disconnect and complete the update.

By default, users can choose to download new client files in the background
and continue working. Clear the Allow Background Download check box to
force users to wait for all client files to download before continuing.

You can optionally enter a message in Display this message on the user
terminal. The user can view this message at the start of the client update by
clicking More Info in the dialog box that appears.

Click Next to continue.
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4. The Event Logging dialog box appears.

Auto Client Update uses the Windows event log to report status messages and
update errors.

� Select the Log Downloaded Clients check box to write an event in the
event log when an ICA Client is updated.

� By default, errors that occur during a client update are written to the event
log. Clear the Log Errors During Download check box to turn off error
logging.

Click Next to continue.

5. The Enable Client dialog box appears.

The client update database can contain multiple clients with the same product,
model, and version information. However, only one client of each product,
model, and version can be enabled. The enabled client is the one used for the
auto client update.

Select the Enable check box to update ICA Clients to this client. All other
clients of the same product, model, and version are disabled.

6. Click Finish to copy the ICA Client installation files into the client update
database.

� To remove an ICA Client from the database

1. In Client Update Configuration, click on the ICA Client to remove.

2. From the Client menu, click Delete. A dialog box displays the selected client
information and asks for confirmation.

3. Click OK to remove the client. The ICA Client is now removed from the
database.

Changing the Properties of an ICA Client in the Database
Use the Properties dialog box to maintain the configuration of an ICA Client in
the client update database. The Properties dialog box contains four tabs: the
Description tab, the Update Options tab, the Event Log tab, and the Client
Files tab.

� To modify the properties of an ICA Client in the database

1. In ICA Client Update Configuration, click on the ICA Client to modify.

2. From the Client menu, click Properties. The Properties dialog box appears.

� The Description tab displays information about the selected client. The
Product, Model, Version, and Client Name are display-only fields.

Type a new description of the client in Comment.
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Select the Enabled check box to update ICA Clients to this client. All
other clients of the same product, model, and version are disabled.

The client update database can contain multiple clients with the same
product, model, and version information. However, only one client of each
product, model, and version can be enabled. The enabled client is the one
used for the auto client update.

� The Update Options tab configures how the client is updated.

In Client Download Mode, click Ask user to give the user the option to
accept or postpone the client update. Click Notify user to notify the user of
the client update and require the update. Click Transparent to update the
user’s ICA Client without notifying the user.

In Version Checking, click Update older client versions only to update
client versions that are older than the new client. Click Update any client
version with this client to update all client versions to this version of the
client. Use this option to force an older client to replace a newer client.

By default, users can choose to disconnect and complete the client update
after the new client files are downloaded. Select the Force Disconnection
check box to require users to disconnect and complete the update.

By default, users can choose to download new client files in the
background and continue working. Clear the Allow Background
Download check box to force users to wait for all client files to download
before continuing.

You can optionally enter a message in Display this message on the user
terminal. The user can view this message at the start of the client update
by clicking More Info in the dialog box that appears.

� The Event Logging tab configures the events to log for the client update.

Auto Client Update uses the Windows event log to report status messages
and update errors.

Select the Log Downloaded Clients check box to write an event in the
event log when an ICA Client is updated.

By default, errors that occur during a client update are written to the event
log. Clear the Log Errors During Download check box to turn off error
logging.

� The Client Files tab displays the individual files for the ICA Client.

The client update database stores the File Name, Group, Flags, FileSize, and
File CRC for each file of an ICA Client.
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Uninstalling the ICA Macintosh Client
To uninstall the ICA Macintosh Client, delete the folder containing the client.

Note You can use the Installer to remove items that it has installed, using the
Custom Remove tab. However, this will not remove clients that were installed
using Auto Client Update.
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3
C H A P T E R 3

Configuring the ICA Macintosh
Client

Overview
This chapter describes how to configure the ICA Macintosh Client. Topics
covered in this chapter include:

� Starting the ICA Client Editor

� Creating a connection file

� Starting an ICA session

� Mapping client devices

� Printing from the Macintosh Client

� Configuring default settings

� Changing a specific connection file

� Improving security
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Starting the ICA Client Editor
You use the ICA Client Editor to create and configure connection files. A
connection file is a file containing configuration options that define the attributes
of an ICA session that you run on a Citrix server. These attributes include window
size and color, initial application and working directory, and client drive and
printer mapping preferences.

Connection files appear as icons on the Macintosh desktop or in a specified
folder.

� To start the ICA Client Editor

Double-click the Citrix ICA Client Editor icon in your ICA Macintosh Client
installation directory.

Making a Connection
You can create two types of connections to Citrix servers: ICA connections and
published applications.

� An ICA connection lets a user access the desktop of a Citrix server. The user
can run any applications available on the desktop, in any order.

� A published application is a predefined application and its associated
environment.

This section describes how to create a basic connection file and start an ICA
session.

Creating a Basic Connection File
First, you need to identify the server or published application to which you want
to connect using this connection file. You can also provide optional user details
that allow you to log on automatically.
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� To create a connection file

1. In your ICA Macintosh Client installation folder, double-click Citrix ICA
Client Editor. The Citrix ICA Client Editor dialog box appears with the
Network Connection page selected:

2. Click Server to connect to a Citrix server or Published Application to
connect to a published application.

3. In the Server box, type the name or IP address of the Citrix server, or the
name of the published application. If server browsing is possible, you can
click the button to the right of the Server box and select the name from a list.

4. To enable automatic logon to the Citrix server when you use this connection
file, enter your user name, the domain (if required), and your password in the
appropriate boxes. If you leave these boxes blank, the Citrix server prompts
for this information each time you make a connection using this file.

5. Click Save. Select a location in which to save the connection file. By default,
the Save connection as box displays the Citrix server or published application
name, but you can give the file a different name if you prefer.

You can click Connect to start the ICA session immediately. If Quit after
connect is selected, the ICA Client Editor exits when the connection is made.
A dialog box appears allowing you to save the connection file, if you have not
already done so.

6. Click Quit to exit the ICA Client Editor.

In addition to these basic settings, each connection file is configured with default
settings that control aspects such as window properties and security features. You
can change these defaults (see “Configuring Default Settings for All
Connections”), or configure a specific connection file to override some of the
defaults (see “Configuring an Existing Connection File”).
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Starting an ICA Session
When you have one or more connection files in place, you can start an ICA
session on a Citrix server.

� To start an ICA session

From within the Citrix ICA Client Editor, choose Open from the File menu and
select a connection file. From the Network Connection page, click Connect.

— or —

From the desktop, double-click the connection file, or drag and drop it onto the
Citrix ICA Connection Center icon.

Note If you cannot connect to a Citrix server, you may need to change the Server
Location (see “Configuring Business Recovery”) or SOCKS proxy details (see
“Improving Security”).

Mapping Client Devices
The Citrix ICA Macintosh Client supports client device mapping for connections
to WINFRAME and MetaFrame for Windows servers. Client device mapping allows
a remote application running on the Citrix server to access devices attached to the
local client computer.

This section includes more information about:

� Mapping client drives

� Mapping client COM ports

� Mapping client audio

Note Client device mapping is not available when connecting to a MetaFrame for
UNIX 1.0 or 1.1 server.

Mapping Client Drives
Client drive mapping allows you to access the local disk drives of the client
computer from ICA sessions. When both the Citrix server and ICA Macintosh
Client are configured to allow client drive mapping, you can access locally stored
files, work with them from ICA sessions, and then save them either on a local
drive or on a drive on the Citrix server

� To map a folder on the Macintosh hard disk to your ICA session

1. Start the Citrix ICA Client Editor

2. From the Citrix ICA Client Editor Options menu, select Default Settings.
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3. In the Citrix ICA Client Editor Default Settings dialog box, select Drive
Mapping from the pop-up menu.

For each server drive letter, the Drive Mapping list shows the disk or path name
of the Macintosh folder mapped to the drive. In the Enabled/read/write column,
icons display whether each mapped drive is enabled for use and what type of
access you have to the drive. Items you cannot change (such as your hard drive)
are grayed out. Items that are no longer available are in italics.

Drives A:, B:, and C: are initially mapped, as follows:

4. Select an available drive letter.

5. Click Modify. Select the folder on the Macintosh hard disk to map and click
the Select bar. The mapped folder appears in the Drive Mapping list. If the
drive letter you selected is not available on the Citrix server, the specified
folder is mapped to another free drive letter.

6. Click Save. Log off from any ICA connections already established and
reconnect.

Drive Mapped to

A: Macintosh removable media drive (for example, floppy or Zip).
Where there is more than one removable drive, you can change
the one to which drive A: is mapped from within an ICA session.
From the Drives menu, select Drive Mappings, then choose
Client A Diskette to display the options. Hold down the Option
key and select the drive you require.

B: Permanently mapped to the Macintosh internal CD or DVD drive.

C: Permanently mapped to the Macintosh hard disk.
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� To view mapped client drives when connected to a MetaFrame server

From within the ICA session, double-click My Computer on the desktop. The
My Computer window appears.

Citrix servers can be configured to remap their server drives. When server drives
are remapped, the local drives may take different drive letters.

Published applications and Citrix server connections that have an initial program
configured offer you the same access to your local drives. When connected to
published applications, a user can access local drives in the same way as when
using applications running locally.

Mapping Client COM Ports
Client COM port mapping allows users to access serial devices on the client
computer as if they were connected to the Citrix server.

Note Client COM port mapping is not supported when connecting to MetaFrame
for UNIX 1.0 and 1.1 servers. It is also not TAPI-compatible. Applications that
communicate with devices using TAPI are not supported.

� To map a client COM port

1. Start the Citrix ICA Client Editor.

2. From the Citrix ICA Client Editor Options menu, select Default Settings.

3. In the Citrix ICA Client Editor Default Settings dialog box, select the
COM Port Mapping page.

4. Select the COM port you want to configure. This is a virtual client COM port
that appears in the ICA session. It does not refer to an actual port on either the
client or server computers.

5. Click Modify to map a local port to the selected COM port. A dialog box
appears.

6. Select the physical port to associate with the selected COM port and click OK.

7. Map other ports as necessary and then click Save to save the new settings.

� To use a mapped client COM port from within an ICA session

1. Start the Citrix ICA Client and log on to a Citrix server.

2. Start a command prompt: on WINFRAME, double-click Command Prompt in
the Main program group. On MetaFrame, click Start, then click Programs,
then click Command Prompt.

3. At the prompt, type net use comx: \\client\comz: where x is the number of the
COM port on the server (ports 1 through 9 are available for mapping) and z is
the number of the client COM port (ports 1 through 4 are available).
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4. To confirm the operation, type net use at the prompt. The list that appears
contains mapped drives, LPT ports, and mapped COM ports.

5. Use this mapped COM port as you would a COM port on the Citrix server.

Mapping Client Audio
Client audio mapping enables a user at the client workstation to hear the sounds
and audio from the application they are using, even though the application is
running on the Citrix server.

Note Client audio mapping is not supported when connecting to MetaFrame for
UNIX 1.0 and 1.1 servers.

Client audio mapping can cause excessive load on the Citrix servers and the
network. The higher the audio quality, the more bandwidth is required to transfer
the audio data. Higher quality audio also uses more server CPU to process. Three
different audio quality settings are available, or you can disable client audio
mapping completely.

An administrator can set the audio quality or enable/disable client audio mapping
on the Citrix server. A user can set the audio quality or enable/disable client audio
mapping for a connection file from the client workstation. If the client and server
audio quality settings are different, the lower of the two qualities is used.

The client audio quality options are:

� High. This setting is recommended only for connections where bandwidth is
plentiful and sound quality is important. This setting allows clients to play a
sound file at its native data rate. Sounds at the highest quality level require
about 1.3Mbps of bandwidth to play clearly. Transmitting this amount of data
can result in increased CPU utilization and network congestion.

� Medium. This setting is recommended for most LAN-based connections. This
setting causes any sounds sent to the client to be compressed to a maximum of
64Kbps. This compression results in a moderate decrease in the quality of the
sound played on the client computer. The host CPU utilization will decrease
compared with the uncompressed version, due to the reduction in the amount
of data being sent across the wire.

� Low. This setting is recommended for low-bandwidth connections, including
most modem connections. This setting causes any sounds sent to the client to
be compressed to a maximum of 16Kbps. This compression results in a
significant decrease in the quality of the sound. The CPU requirements and
benefits of this setting are similar to those of the Medium setting; however, the
lower data rate allows reasonable performance for a low-bandwidth
connection.
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� To enable or disable ICA Client audio on a MetaFrame for Windows server

1. Click ICA Settings in Terminal Server Connection Configuration.

2. Select an option from the Client Audio Quality drop-down list.

� To enable or disable ICA Client audio on a WINFRAME server

1. Click ICA Settings in Citrix Connection Configuration.

2. Select an option from the Client Audio Quality drop-down list.

� To configure audio mapping for a specific connection file

1. Start the Citrix ICA Client Editor and open the connection file you want to
change.

2. Select Connection Properties from the pop-up list in the ICA Client Editor
dialog box.

3. Select Enable Sound to enable sound support.

4. Set Quality to High, Medium, or Low, depending on the available
bandwidth.

Printing From the Macintosh Client
You can access printers attached to your client computer from an ICA session.
When a Citrix server is configured to allow client printer mapping, applications
running remotely on the Citrix server can print to local printers. With the Citrix
ICA Macintosh Client, you can print to a PostScript printer or to a PC printer
connected to the Macintosh serial port.

You can disable printing for individual connection files in the Connection
Properties page of the Citrix ICA Client Editor dialog box. For instructions,
see “Configuring an Existing Connection File.”

Note Printing to a PC printer requires the PowerPrint package from Infowave
Wireless Messaging Inc. (http://www.infowave.com).

After configuring client printing, you must log off and then reconnect any active
ICA sessions for the changes to take effect. Changes made to your printer
mapping configuration apply to all connection files.

� To configure a local printer for client printing

1. If necessary, install the appropriate printer driver on your Macintosh and select
it in the Macintosh Chooser.

2. Using SimpleText or any other suitable application, verify that you can print to
the printer from your Macintosh.
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3. Start the Citrix ICA Client Editor.

4. From the Citrix ICA Client Editor Options menu, select Default Settings.

5. In the Citrix ICA Client Editor Default Settings dialog box, select Printer
Setup from the pop-up menu. The Printer Setup screen appears.

6. In the Local Printer Type box, select PostScript Printer to map a local
PostScript printer or Direct Printer to map a local PC printer. To disable
printing for all ICA sessions, select None.

7. Select your printer from the list. If it is not listed, click Add... and type the
name exactly as it appears in the Citrix server’s list of printer drivers. Click
OK to return to the Default Settings dialog box.

To see a list of printer drivers on a MetaFrame for Windows server, first
connect to the server using the Citrix ICA Client. On a WINFRAME server, start
Print Manager and run the Create Printer wizard. The driver list contains
printer names as they should be specified. On a MetaFrame server, click
Printers in Control Panel. Start the Add Printer wizard and continue through
its screens until you reach the screen that contains the list of printers by
manufacturer.

8. Click Save.

If your client printer is not automatically available on the Citrix server, you can
manually add it in the ICA session. Use the following procedures to manually add
a client printer.
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Mapping Client Printers on MetaFrame for Windows and
WINFRAME

Client printer mapping lets users access spooled printers available to the
workstation during ICA sessions. When a Citrix server is configured to allow
client printer mapping, applications running remotely on the Citrix server can
print to a spooled printer.

� To map a local printer on a MetaFrame for Windows server

1. From the UNIX workstation, start an ICA connection and log on to the
MetaFrame server.

2. Click Start on the taskbar, point to Settings, then click Printers.

3. In the Printers window, you will see an icon for a network printer with a
name similar to workstation#printer, where workstation is the UNIX
workstation name and printer is the UNIX name for the printer.

4. If no client printer is available, double-click Add Printer. The Add Printer
Wizard appears.

5. Click Network printer server and then click Next.

6. Double-click Client Network and then double-click Client.

7. Select the printer from the list displayed. Spooled printers available on the
UNIX workstation have a name similar to workstation#printer. Click OK.

8. If you want this printer to be the default printer, click Yes and then click Next.

9. Click Finish.

� To map a local printer on a WINFRAME server

1. Log on to the WINFRAME server.

2. In the Main program group, double-click Print Manager. In the Printer
Manager window, you will see an icon or open dialog box for a network
printer with a name similar to workstation#printer, where workstation is the
UNIX workstation name and printer is the UNIX name for the printer.

3. If no client printer is available, select Connect to Printer from the Printer
menu.

4. From the Shared Printer list, double-click Client Network and then double-
click Client.

5. Select the client printer icon, which will have a name similar to
workstation#printer, and click OK.

6. If you want this printer to be your default printer, select it from the Default
menu at the top of the Printers window.
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Mapping Client Printers on MetaFrame for UNIX
Before users can print to a client printer from MetaFrame for UNIX, printing
must be enabled by the administrator. This section describes how to enable
printing on the server. It describes how users can list available client printers and
print files from the command line or from applications.

In a UNIX environment, the application performs the print rendering. The printer
driver is specified inside the application or, in the case of a desktop utility, raw
text is generated.

Note For further information about printing on MetaFrame for UNIX Operating
Systems, see the MetaFrame Administrator’s Guide and the manual pages.

Setting up Printing
� To check if client printing is currently enabled or disabled

1. Log on to the MetaFrame server as a Citrix server administrator.

2. At the command prompt, type:

ctxcfg -p list

� To enable or disable client printing

1. Log on to the MetaFrame server as a Citrix server administrator.

2. At the command prompt:
:

� To display mapped client printers

At the command prompt, type:

ctxprinters

A list of printers configured on the client and mapped for use from the ICA
session is displayed. (default) is displayed after the printer that is the default. The
following information is shown for each printer:

� Printer name or printer port (for example, lpt1). This can be used in the ctxlpr
-P command to specify a printer other than the default.

� Printer driver name. This is for information only.

� Printer connection description. This is for information only.

To Use the command

Enable client printing ctxcfg -p enable

Disable client printing ctxcfg -p disable
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Using Printing
� To print a file from an ICA Client session

1. At the command prompt, type:

ctxprinters

2. From the results of ctxprinters, identify the printer or printer port that you
want to use. To print to a printer other than the default, note the printer
name—the printer name is the first item in the ctxprinters listing.

3. At the command prompt:

� To print from applications

The exact configuration of how to set up printing from applications depends on
the behavior and user interface of the UNIX application.

If the user interface for an application allows you to specify the actual printer
command to use when printing, you can configure client printing by replacing the
lpr or lp command with the ctxlpr command.

When a user connects to the server and prints from the application in a session,
the server redirects the output to the mapped client printer.

Often, in this type of application, you can also specify the command line
modifiers on a different line. You can use the same switches for ctxlpr as when
printing from the command line. For example, use -P with a printer name (or
printer port) to print to a printer other than the default; use -b for background
printing, and so on.

To Use the command

Print the file named filename to the default printer. ctxlpr filename

Print a series of files to the default printer. Each file
is treated as a separate print job.

ctxlpr filename filename

Print a file to a printer (or printer port) other than the
default. This is the printer name or printer port
shown in the first column of the output from
ctxprinters.

ctxlpr -P [Printername | 

Printerport] filename

Print a file in the background. ctxlpr -b filename

Print a file only if the printer is not in use. Use this
option to stop an application waiting while other
printer jobs are handled. If the printer is in use, an
error message is displayed.

ctxlpr -n filename
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Tip If the user interface of an application does not allow you to specify the actual
printer command to use when printing, determine if the application (or window
manager) uses a configuration file where you can replace the lpr command
functionality with ctxlpr.

Configuring Default Settings for All Connections
You can specify default settings that are applied to all ICA connections. You can
override some of these settings for specific connections - see “Configuring an
Existing Connection File” for details.

� To configure default settings

1. Start the Citrix ICA Client Editor.

2. From the Citrix ICA Client Editor Options menu, select Default Settings.
The Citrix ICA Client Editor Default Settings dialog box appears.

The Citrix ICA Client Editor Default Settings dialog box has the following pages,
corresponding to the properties you can control:

Use this To configure

Window Default size and color depth to use for ICA session windows.

Preferences Options for playing Windows alert sounds, automatic client
update, text-only copying from sessions, and the default
encryption level.

Printer Setup Settings for client printing 1

Drive Mapping Settings for client drive mapping 2
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Configuring Default Window Settings
You can change the size and color depth of the window used for ICA connections.

� To change the default window settings

1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,
from the Citrix ICA Client Editor Options menu, select Default Settings.

2. From the pop-up list at the top of the Default Settings dialog box, select the
Window page.

3. To change the Window Size, do one of the following:

� Select Fixed, then choose one of the available sizes from the list box.

� Select Custom, then type the required dimensions, in pixels, in the Width
and Height boxes. The maximum window size is determined by the server.

Disk Cache Settings for persistent bitmap cache

Server Location Settings for Business Recovery, SOCKS proxy configuration 3,
and alternate address remapping

Com Port Mapping Settings for client COM port mapping 2

Hot Keys Settings to change the hotkeys for the client.

Japanese Hot Keys Settings to change the hotkeys assigned to Japanese functions.

1 Client printing is described in “Printing From the Macintosh Client.”
2 Client device mapping is described in “Mapping Client Devices.”
3 SOCKS proxy configuration is described in “Improving Security.”

Use this To configure
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� Select Use Full Screen to use the entire area of your screen for the ICA
connection.

Note If you select Use Full Screen, the menu bar is hidden when you run the
Citrix ICA Macintosh Client. To access the Macintosh menu bar, hold down
the Option and Control keys. To make the menu bar display permanently, open
the File menu in the Citrix ICA Macintosh Client and choose Best.

4. Use Window Colors to set the number of window colors to 16, 256,
Thousands, or Millions.

Note For best performance, Window Colors should match the number of
colors set in your Macintosh Monitors control panel. When this is the case, a
diamond shape is displayed in the title bar during an ICA session.

5. Click Save.

Configuring Default Preferences
You can configure settings for playing Windows alert sounds, automatically
quitting the ICA Client after the ICA session ends, automatic client update, text-
only copying from sessions, and the default encryption level.

� To configure the default preferences

1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,
from the Citrix ICA Client Editor Options menu, select Default Settings.

2. From the pop-up list at the top of the Default Settings dialog box, select the
Preferences page.

Change the settings as required. You can do the following:

Use this To configure

Enable Windows
Alert Sounds

Select this to play the default Macintosh beep when an application
in the ICA session triggers the default Windows beep.

Allow Automatic
Client Updates

Select this to allow the Citrix server to update the Citrix ICA
Macintosh Client when newer versions become available. When
the server detects an outdated client version, it notifies the user
that a newer version is available and replaces the Citrix ICA
Macintosh Client files. Note that this feature is not supported by
servers running WINFRAME 1.7 or earlier, or on MetaFrame for
UNIX 1.0 or 1.1 servers.
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3. Click Save.

Configuring Disk Caching
The Citrix ICA Macintosh Client stores commonly-used graphical objects such as
bitmaps in a local cache on the client computer’s hard disk.

Note Although you can configure the default disk cache settings, disk caching is
not used unless you enable it for a particular connection file. Disk caching for
individual connection files is enabled on the Connection Properties page of the
ICA Client Editor dialog box. See “Configuring an Existing Connection File.”

� To configure disk caching:

1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,
from the Citrix ICA Client Editor Options menu, select Default Settings.

2. From the pop-up list at the top of the Default Settings dialog box, select the
Disk Cache page.

3. Change the settings as required. You can do the following:

� Change the Amount of disk space to use by adjusting the percentage of
the total size of the disk that contains the cache folder.

� Use a different Disk cache folder (the default directory where the cached
data is stored). To do this, click Change Folder..., browse and select.

� For The minimum size bitmap that will be cached is..., specify the size
(between 2 and 64 kilobytes) of the smallest bitmap to be cached to disk.

� To remove all cached data from the client computer, click Clear Disk
Cache Now.

4. Click Save.

Copy from Session
as Text Only (No
Graphics)

Select this to ensure that any material you copy from the session
to the local desktop is pasted in text format rather than picture
format. (If only graphics format is available, the material is still
copied in graphics format.)

Encryption Level Set the default Encryption Level for connections. Note that the
server must be configured to allow the selected encryption level
or greater. To enable encryption levels higher than Basic, the
Citrix server must support RC5 encryption. This support is
included with SecureICA Services and Feature Release 1.
SecureICA Services is not supported by all Citrix servers. For
specific connections, you can either use this default or set a
different level; see “Improving Security.”

Use this To configure
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Configuring Business Recovery
This feature provides consistent connections to published applications in the
event of a master ICA Browser server disruption. You can define up to three
groups of Citrix servers to which you want to connect: a primary and two
backups. Each group can contain up to five servers.

When you configure Business Recovery, the client attempts to contact all the
servers within the Primary group simultaneously (broadcasting); the first server
to respond acts as the master ICA Browser. If none of the servers responds, the
client attempts to contact all the servers within the Backup 1 group. If there is still
no response, the client attempts to contact all of the servers in the Backup 2
group. When a server responds, the client queries the server for the address of the
server on which to run the published application. This process is repeated each
time the user attempts to make an ICA connection.

Tip It is a good idea to specify the server address for the Citrix server that
functions as the master browser when your network configuration uses routers or
gateways, or if you want to eliminate the broadcasts on your network.

� To configure Business Recovery server groups

1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,
from the Citrix ICA Client Editor Options menu, select Default Settings.

2. From the pop-up list at the top of the Default Settings dialog box, select the
Server Location page.

3. From the Server Group list, select the server group you want to configure.

4. Click Add... to add a server to the selected group.

5. In the Server box, type or select the name of the server, then click OK.

6. Add more servers as necessary.

7. To change the protocol used when locating the master browser, click Network
Protocol and choose a protocol from the drop-down list. If your firewall
restricts UDP broadcasts, select TCP/IP+HTTP from the list.

8. Click Save.

You can specify separate server groups for each protocol.
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Configuring Hotkeys
You can change the combination of key presses used for system hotkeys.

� To display or change the hotkeys:

1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,
from the Citrix ICA Client Editor Options menu, select Default Settings.

2. From the pop-up list at the top of the Default Settings dialog box, select the
Hotkeys page or the Japanese Hotkeys page. A dialog box appears, showing
the current list of hotkeys.

3. Highlight the function for which you want to change the hotkey and click
Define... to display a dialog box for that function.

4. Select the main key for the function, then use the check boxes to select the
additional keystrokes.

5. Click OK to close the dialog box for the function.

6. Click Save.

Configuring an Existing Connection File
This section describes how to change the properties of a specific connection file.
Some of these properties override the default settings. For details of the default
settings, see “Configuring Default Settings for All Connections.”

“Making a Connection” gives basic instructions for creating a connection file.

� To edit an existing connection file

1. From within the Citrix ICA Client Editor, choose Open from the File menu
and select the connection you want to edit.

2. The Citrix ICA Client Editor dialog box appears, showing the current
properties of the connection file.

3. Edit the properties you want to change and then click Save to save the
connection file, or choose Save or Save As... from the File menu.

You can configure the connection file using the following pages in the Citrix
ICA Client Editor:

Use this To configure

Network Connection The basic settings required to establish a connection with a Citrix
server. For details, see “Making a Connection.”

Security Settings for using a SOCKS proxy server, and encryption levels.
For details, see “Improving Security.”
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Configuring Connection Properties
Settings on the Connection Properties page allow you to improve performance
by reducing bandwidth use. You can also control sound support and enable or
disable local printing and drive mapping for this connection file.

� To change the connection properties

1. From within the Citrix ICA Client Editor, choose Open from the File menu
and select the connection file you want to edit.

2. Select Connection Properties from the pop-up list in the ICA Client Editor
dialog box.

3. Change the settings as required.

4. Click Save.

You can configure the following Connection Properties:

Connection
Properties

Settings allowing you to control the connection between the Citrix
server and the client workstation. For details, see “Configuring
Connection Properties.”

Window The size and color depth to use for ICA session windows for this
connection file. See “Configuring Window Properties.”

Application Allows you to specify the path and file name of an application to
be executed after connecting to the Citrix server. For details, see
“Configuring Application Properties.”

Use this To configure

Use this To configure

Use Data
Compression

Check this box to enable data compression. Data compression
reduces the amount of data sent over the connection but consumes
a small amount of processor time to perform the compression and
decompression. In high-bandwidth LAN environments where
bandwidth consumption is not a concern, disabling data
compression may give better performance.

Use Disk Cache for
Bitmaps

Check this box to enable persistent bitmap caching. The client
stores cached bitmaps in a local directory to reduce the amount of
data sent over the connection. Because the cached bitmaps are
stored on hard disk, commonly used bitmaps can be displayed
more quickly.

Enable Sound /
Quality

Use these settings to enable sound support and configure the
sound quality. See “Configuring Sound Support”.
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Configuring Sound Support
You can configure sound support for a connection file using settings on the
Connection Properties page of the Citrix ICA Client Editor.

� To configure sound support for a connection file

1. Check the Enable Sound box to enable full sound support. All audio played
in the ICA session is sent over the ICA connection and played on the client
computer. For details of client audio mapping, see “Mapping Client Devices.”

2. Use the Quality setting to configure the sound quality, by choosing one of the
values listed below. For full details of these client audio mapping options, see
“Mapping Client Devices.”

� High. This value provides the greatest audio quality but should only be
used when bandwidth consumption is not a concern.

� Medium. Using this value results in less bandwidth consumption than
when using High. Compression of sound data provides greater bandwidth
efficiency but reduces sound quality somewhat. This value is
recommended for most LAN-based connections.

� Low. This value offers the most efficient use of bandwidth but also
decreases sound quality severely. This value is recommended for low-
bandwidth connections, including most modem connections.

Disable local printer
for connection to
this server

Check this box to disable local printing for connections to this
server or published application. For more information about local
printing, see “Printing From the Macintosh Client.”

Disable drive
mapping for
connection to this
server

Check this box to disable drive mapping for connections to this
server or published application. For more information about drive
mapping, see “Mapping Client Devices.”

SpeedScreen On servers where SpeedScreen Latency Reduction is available,
this option allows you to configure the way in which it is used.
See “Configuring SpeedScreen Latency Reduction” below.

Use this To configure
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Configuring SpeedScreen Latency Reduction
On servers where SpeedScreen Latency Reduction is available, you can configure
it on the Connection Properties page of the Citrix ICA Client Editor.

� Keyboard: This setting controls Local Text Echo. Over high latency
connections, users often experience significant delays between when they
enter text at the keyboard and when it is echoed or displayed on the screen.
Local text echo is an ICA Client option that accelerates the display of the input
text on the client device, effectively shielding the user from experiencing
latency on the network

� Mouse: click feedback: Over high latency connections, users often click the
mouse multiple times because there is no visual feedback that a mouse-click
resulted in an action. Mouse click feedback provides visual feedback for
mouse-clicks. When the user clicks the mouse, the ICA software immediately
changes the mouse pointer to an hourglass to show that the user’s input is
being processed.

� To configure SpeedScreen Latency Reduction for a connection file

For each of the Keyboard and Mouse settings, select one of the following:

� Auto. If you are not certain of the connection speed, set the mode to Auto to
turn the feature on or off depending on the latency of the connection.

� On. Choose On for slower connections (for example, over a WAN or a dial-in
connection) to decrease the delay between user input and screen display.

� Off. Choose Off for faster connections (for example, over a LAN).

Note You can override the selected SpeedScreen mode for the current session by
using the Latency Reduction hotkey. See “Configuring Default Settings for All
Connections” for details of hotkeys.
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Configuring Window Properties
The Window page allows you to specify the window size and number of colors
used for the ICA Client window.

� To configure the window properties for a connection file

1. From within the Citrix ICA Client Editor, choose Open from the File menu
and select the connection file you want to edit.

2. Select Window from the pop-up list in the ICA Client Editor dialog box.

3. To change the Window Size, do one of the following:

� Select Fixed, then choose one of the available sizes from the list box.

� Select Custom, then type the required dimensions, in pixels, in the Width
and Height boxes. The maximum window size is determined by the server.

� Select Use Full Screen to use the entire area of your screen for the ICA
connection.

Note If you select Use Full Screen, the menu bar is hidden when you run the
Citrix ICA Macintosh Client. To access the Macintosh menu bar, hold down
the Option and Control keys. To make the menu bar display permanently, open
the File menu in the Citrix ICA Macintosh Client and choose Best.

4. Use Window Colors to set the number of window colors to 16, 256,
Thousands, or Millions.

Note For best performance, Window Colors should match the number of
colors set in your Macintosh Monitors control panel. When this is the case, a
diamond shape is displayed in the title bar during an ICA session.

5. Click Save.

Configuring Application Properties
The Application page allows you to specify an application to be executed after
connecting to a Citrix server using this connection file. If you specify an
application, you do not see the Citrix server desktop when you connect and the
connection is closed when you exit from the application.

If you specify an application, no other application can be run in the ICA session.
You are not able to use Program Manager on WINFRAME or the Windows desktop
on MetaFrame.

Note The Application dialog box is not available when configuring a connection
to a published application.
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� To configure application properties

1. From within the Citrix ICA Client Editor, choose Open from the File menu
and select the connection file you want to edit.

2. Select Application from the pop-up list in the ICA Client Editor dialog box.

3. Specify the path and file name of the application to be executed after
connecting to the Citrix server.

For example, to launch Microsoft Word automatically after connecting to the
Citrix server you might type:

C:\WINWORD\WINWORD.EXE

4. Specify the working directory to be used for the application in the Working
Directory box.

Improving Security
This section describes how to configure an ICA connection through a SOCKS
proxy server or across a firewall, and how to set encryption. SOCKS proxy
servers and firewalls are used on networks to improve security. Encryption
increases the security of the ICA connection itself.

Connecting Through a SOCKS Proxy Server
To limit access into and out of your Citrix servers, configure a SOCKS proxy
server to handle connections between clients and the server. You can place the
proxy server on either side of the firewall, or in some situations, on both sides of
the firewall.

If you are using a SOCKS proxy server, you must configure the ICA Macintosh
Client to connect to Citrix servers through a SOCKS proxy server. You can
configure a default SOCKS proxy for all connections or use a SOCKS proxy only
with a specific connection file.

� To configure a SOCKS proxy server for an ICA connection

1. From within the Citrix ICA Client Editor, choose Open from the File menu
and select the connection file you want to edit.

2. The Citrix ICA Client Editor dialog box appears, showing the current
properties of the connection file.

3. From the pop-up list at the top of the ICA Client Editor dialog box, select the
Security page.

4. Click Connect via SOCKS proxy.

5. In the Address of proxy to use box, enter the name or IP address of the
SOCKS proxy server.

6. In the Port box, enter the proxy server’s port number (if it is not 1080).
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7. Click Save to save the changes to the connection file.

� To specify a default SOCKS proxy

1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,
from the Options menu, select Default Settings.

2. From the pop-up list at the top of the Default Settings dialog box, select the
Server Location page.

3. Click Firewalls.

4. Click Connect via SOCKS proxy.

5. In the Address of proxy to use box, enter the name or IP address of the
SOCKS proxy server.

6. In the Port box, enter the proxy server’s port number (if it is not 1080).

7. Click OK to close the pop-up dialog box, and then click Save to close the
Default Settings dialog box.

Note Because you can enter only one SOCKS proxy server address, you cannot
configure Business Recovery with separate SOCKS settings for different server
groups.

Connecting Across a Firewall
If the ICA Client is outside a firewall that uses address remapping, you configure
the ICA Client to use the alternate address returned by the master ICA Browser.
This is necessary even if you are not using a SOCKS proxy server.

Note You must also use the ALTADDR utility, or ctxalt for MetaFrame for
UNIX, to manually set the alternate address for each Citrix server. See the
Command Reference appendix of either the MetaFrame Administrator’s Guide or
the WINFRAME System Guide for more information.

� To configure the ICA Macintosh Client to use the alternate address

1. If the Citrix ICA Client Editor Default Settings dialog box is not displayed,
from the Options menu, select Default Settings.

2. From the pop-up list at the top of the Default Settings dialog box, select the
Server Location page.

3. Click Firewalls.... A dialog box appears.

4. Click Use alternate address for firewall connection and then click OK to
close the dialog box.

5. In the Default Settings dialog box, click Save to save the new settings.



Chapter 3 Configuring the ICA Macintosh Client 45

Using Encryption
Encryption increases the security of your ICA connection. By default, basic
encryption is enabled on all connections. If the Citrix server you are connecting to
supports advanced encryption (for example, SecureICA Services), you can use it
to improve security.

Note To enable encryption levels higher than Basic, the Citrix server must
support RC5 encryption. This support is included with SecureICA Services and
Feature Release 1. SecureICA Services is not supported by all Citrix servers.

� To change the encryption settings for an ICA connection

From within the Citrix ICA Client Editor, choose Open from the File menu and
select the connection file you want to edit.

— or —

From the desktop, drag the connection file and drop it onto the Citrix ICA Client
Editor icon.

Either choose Use Default Level (see “Configuring Default Preferences” for
instructions on how to set this default) or select an encryption level from the list
box.

Note The server must be configured to allow the selected encryption level or
greater.
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Using Applications Published on a MetaFrame for UNIX
Server

For connections to applications published on a MetaFrame for UNIX server, two
additional utilities allow you to configure session display and copyg and paste
objects between the ICA session and the client device. This section describes how
to access and use these tools through the Citrix window manager.

Using the Window Manager
If you are connecting to an application published on a MetaFrame for UNIX
server, use the Citrix window manager (ctxwm) to minimize, resize, position and
close windows. This section describes how to use the window manager.

Minimizing, Resizing, Positioning, and Closing Windows
When you connect to a published application on a MetaFrame for UNIX server,
buttons to minimize, resize, position, and close windows are provided by the
Citrix window manager.

� To minimize, resize, position, and close windows

Use the left mouse button, to click on the following buttons:

To Click Note

Minimize published
application
windows on your
desktop.

Windows are minimized as icons on the
desktop.

Open a minimized
window

(Taskbar or

Icon)

Click its button on the taskbar, or its icon on
the desktop.

Adjust the size of
published
application
windows.

Click and hold down the mouse button, then
move the pointer to the edge of the window
and drag it in the direction you wish to scale
it. The window dimensions are displayed in
the top left hand corner. Release the mouse
button to apply the resizing.
To resize the window proportionately, move
the mouse pointer to a corner of the window
and drag it.
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Using the Citrix Window Manager Menus
In remote desktop windows, you can use the ctxwm menu system to log off,
disconnect, and exit from published applications and connection sessions.

� To access the ctxwm menu system

1. On a blank area of the remote desktop window, click and hold down the left
mouse button. The ctxwm menu is displayed.

2. Drag the mouse pointer over Shutdown to display the shutdown options.

� To choose an option from the Citrix window manager menu

Drag the pointer over the required option to highlight it. Release the mouse
button to select the option.

Note Your Citrix server may be configured to terminate any applications that are
running if a session is disconnected.

To Click Note

Re-position
published
application
windows

(Title-bar)

Click and hold down the mouse button, drag
the window to the required position on the
desktop and release the mouse button.

Close and exit a
published
application

When you close the last application in a
session, after 20 seconds the session
disconnects automatically.

To Choose

Terminate the connection and all
running applications

Logoff

Disconnect the session but leave the
application running

Disconnect

Disconnect the session and
terminate the application

Exit
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